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 OmegaT (OT) is a free open-source CAT Tool that was developed, by private initiative, originally by Keith Godfrey 
in 2000 and that has being vastly improved since then with many contributions (see OmegaT ðHelp ð About for a list 
of contributors). Didier Briel is its present project manager. OmegaT is now the leader open-source CAT tool. 
OmegaT is being used by DGT for prototyping since 2012, prior to the acquisition of a commercial CAT tool. For that 
purpose, the 2.6.0_3 version of OmegaT was customised and extended to integrate other DGT tools (called internally 
DGT-OmegaT to differentiate it from the public version).  
In June 2012, DGT-OmegaT and its Project Wizard were made available to all DGT translators interested in using it.   
DGT has in the meantime updated its OmegaT version to the 3.1.2 public version (DGT-OmegaT 2014). 

As OmegaT has evolved quite a lot in the last 2 years ¾ and the full Guide is getting bigger all the time… ¾  this Quick 
Guide aims to give you enough information to start translating with OmegaT right away with a minimum of effort. 
But if you want to know more about OmegaT features in general or some feature in particular, see the relevant section(s) 
in DGT-OmegaT 2014, its Project Wizard and DGT’s CAT Environment - A Translator’s Guide and the other Guides 
available by clicking on Other Guides in the DGT-OT Project Wizard. 
I also posted 3 videos for the 2012 version of DGT-OmegaT (50 minutes on the whole: Video 1, Video 2 and Video 3 - 
DGT and its Project Wizard in a nutshell) as it is so much easier to show than to explain! Most of its content continues 
to apply to the new version of DGT-OmegaT. 
For translators who already used DGT-OmegaT 2012, there are a few minor changes, but basically it is the same… with 
improved/new features, of course. 

 
Screenshot 1 – OmegaT panes: Editor, Fuzzy Matches, Machine Translation, Glossary, Notes, Multiple 

Translations and also the Translation Tips (Transtips) feature. Dictionary and comments panes minimized.  
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 DGT has also developed in-house a DGT-OmegaT Project Wizard (DGT-OT Wizard) to integrate OmegaT in its 
workflow and this Quick Guide includes the general information you need to manage your projects easily. 

The DGT-OT Wizard makes the link between Tradesk ¾ our document management system ¾ and OmegaT and helps 
you to quickly create projects with all the reference/retrieval/MT translation memories and also an IATE extraction. 
You can also easily update projects with new original documents/new versions of documents already in the project 
and/or new memories, delete documents/memories from the project, add glossaries, organise translation memories, and 
archive finalised projects. 
The final part of the workflow – sending (ongoing or finished) translated documents to Tradesk and the documents 
memories to Euramis – you will have to do manually for the moment, but it is simple and fast.  
The DGT-OT Wizard also triggers automatic backups (every 10 minutes) of your active project to a server (your space in 
the H: drive) in a background operation you don’t see. 

The DGT-OT Wizard is easy to use as ¾ for many of the project management operations ¾ it just opens a Windows 
Explorer window and there you can copy, paste, delete, drag/drop and rename files in the usual manner.  
For a general explanation of the OmegaT Wizard features, see Section 6 of this .  
 

 
Screenshot 2 — DGT-OmegaT Project Wizard window and features 
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When you create a new project, the DGT-OT Wizard creates a project folder in your computer with the following 
structure: 

 
Screenshot 3 — DGT-OmegaT project structure. Some folders\file are DGT-specific and/or are created during the 

translation of the project.  
 
The DGT-OT Wizard also makes it easy to share memories in real time by connecting you to the in-house TeamBase 
application in a simple way.  
 

 
Screenshot 4 — TeamBase window 
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This is a brief overview of the features available in OmegaT and its Wizard to give you a general idea of how it works. 

1 – : Now, all CAT tools follow a multi-document project approach. We work within projects, which 
may have one or several/many documents — with hundreds/thousands of pages on the whole — that are treated in a 
single project in a speedy way, even when there are successive new versions during the translation of the project.  

 Each document is individually identified in the Editor pane so that you always know where you are. 
 In the DGT-OmegaT project, you have all the memories (retrievals, reference translation memories and MT output) 

and an IATE extraction (automatically imported to each project) and you can also add other glossaries, dictionaries 
and monolingual reference documents.  

 Furthermore you can also gather in your project folder other material – technical or administrative — that you may 
need to manage/translate your project.  

2 –   
 The original documents can be: 

a) One, some or all documents of large packages (European Semester, Budget, Rail, Multiannual Financial 
Framework, for example) with different dossier and part numbers (Example: RTD-2014-80020-00-00 + RTD-
2014-80020-00-01 + RTD-2014-80021-00-00 + RTD-2014-80023-00-00) 

b) Documents of dossiers with numerous parts (like a model contract with several parts),  
c)  SRC files (usually Excel or PowerPoint files with tables, graphs), 
d) New versions of documents (quite frequent), 
e) Several small documents which you may want to gather in a project (like several replies to parliamentary 

questions, cartouches) even if unrelated, just to save time, 
f) Any combination of these.  
If your documents have a subfolder structure, OT will keep it. You can also easily change the order in which OT 
displays the documents in your project. 
In the present implementation of DGT-OmegaT, the source documents are not converted to xliff format. So you 
have as source the original document and OT saves your translation to the project memory. 

3 –  The documents to translate may be in different formats (Word, Excel, PowerPoint, x(html), 
etc.), but they will all be displayed the same way as “raw” text in the Editor pane.  

4 – With Budget documents, there is no problem, you 
can use OmegaT. With Recast documents, it is not possible to use OmegaT and you will have to use the old TWB.  

5 – Projects can be easily created locally, directly in OmegaT, in the case of 
documents that cannot be transmitted via the network (SECEM documents, for instance).

6 – : Inline formatting is displayed in the form of tags (Example: <t0/>).  
You will only see what is called “inline tags” (i.e., tags inside the segment) and not all the tags related to styles or to 
the whole segment.  By placing with the mouse over each tag, you will see its description (in a very cryptic way!). It 
is mostly useful to see if it is a footnote (which is not to be missed!). 
If you want, you can also translate with Remove Tags activated, which means that you will not have any tags at all 
in the documents … but afterwards you (or the Unit secretariat) will have to add the formatting manually in the 
document(s) in their native application. 
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To work without tags, in the Project ð Properties menu, tick the Remove Tags box. You can change your mind at 
any time (as the tags are only hidden, not removed), but it is not recommended to change from tags/no tags mode 
in the middle of a document/project.  
If you do, some segments you already translated will be “orphans” because they will no longer match (tags 
included) any segment in your document. Those segments will therefore be displayed as untranslated in the Editor 
and the previously translated segments – no longer a 100% match – will be displayed in the Fuzzy Matches pane 
(as “orphans”). 

7 – : All the documents in your project are, by default, automatically merged and treated 
as a whole. The auto-propagation of the translation of identical source segments (non-unique segments) is done 
automatically for the whole project — in a background operation you do not see — and those segments are 
displayed greyed. 
OT numbers the segments sequentially from the first segment of the first document to the last segment of the last 
document, but it displays the name of each individual document in the Editor ribbon so that you always know what 
document you are working on.  

8 – : OT cannot have several documents open at the same time, but as it treats 
your project globally, its powerful Search feature will search in all the documents inside your project — no matter 
how many they are — and the Fuzzy Matches pane will display matches (in OT, Fuzzy Match comprises 100% 
matches) from all the documents in the project.  

 You can also do Search/Replace in all the documents.  
9 – : In OT, there are 2 segment statuses — untranslated and translated. All translated segments 

are stored in the project memory and are available for Fuzzy Matches. 

10 –  OT provides statistics for the documents within your project and match statistics for the whole project 
and for each document, with the indication of repetitions in documents and between documents, something which 
is very useful for the documents in a project to be split, if necessary, between translators in the most efficient way.  

 

 
Screenshot 5 – Statistics for the whole project 

 
Screenshot 6 – Match statistics for the whole project 
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Screenshot 7 — Match Statistics per File 

It also provides statistics of how much you have already translated and what remains to be translated. Besides, it 
displays and continuously updates the number of (unique) translated/non translated segments, by document and 
for the whole project. 

 

15/615 Number of segments – translated vs. total for the current file 

14/551 Number of unique segments – translated vs. total in the project 

615 Total number of segments (including repeats) in the project 

123/146 Number of source and target characters in the current segment 

Screenshot 8 – Real-time statistics displayed at the bottom right of the OT window 
You also have automatically copied to your project main folder an empty Excel sheet template — OT_Stats — in 
which you can record manually your progress in the translation of your project, just by copying/pasting the data in 
the statistics given by OT as shown above. You can access it via the DGT-OT Wizard, by clicking on the box Stats. 

 
Screenshot 9 — Statistics excel sheet (example) 



DGT-OMEGAT AND ITS WIZARD — Quick Guide — MJM — April  2015 — DGT-OmegaT-3.1.2_3+DGT Extensions 2.3. beta update 5 
 

8 
 

 

11 – : OT preferences are 1-level and OT will “remember” the last preferences you set when you close 
and reopen it, either with the same project or with another project. Of course, you can easily change the 
preferences at any time. 

12 – : There are several options (display only target or source and target 
segments; mark non-unique segments, auto-populated  (pre-translated) segments, revised segments; segments 
with notes, translated segments, non-translated segments, modification info, etc.).  
You can choose at different stages of your translation to have them displayed differently just by clicking or 
unclicking that option in the View menu. When the option is active, the coloured box is marked with a line around it. 

 

 
Screenshot 10 – View menu 

13- : In the Options ð Fonts menu, you can also change the size and font of the display — in the Editor 
and in the other panes — depending on what you find more comfortable.  

14 – : You can minimize or maximize each pane by double-clicking 
on the ribbon of each pane and selecting the option you want.  
You can undock the panes by selecting that option, clicking on the right mouse button and ¾ keeping it pressed 
over the ribbon ¾ dragging the pane to the desired position. The only pane that cannot be undocked is the Editor. 
If you want to return to the default pane display, in the Options menu, select Restore Main Window. 

15 – : You cannot print the document as seen in the Editor, you can only print the document in its native 
application.  

16 – : For the moment, use the Upload feature of Tradesk to copy, 
at the end or any time during the translation process, your translated document(s) from your computer to Tradesk.  

17 - Now you can send manually the memories of 
your translations to Euramis. 
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1 – : If you are a teleworker, OmegaT will not slow you down as it is not a 
resource-hungry application and backups are done in a fast background process without your noticing it.  
If you are not a teleworker, but you sporadically need to translate at home, you can use OT just by copying it to 
your private computer (of course without access to DGT databases) as there are no license issues. 

2 – : You can share memories in real time using the in-house 
TeamBase application. With it, you can control when and how you want to work in share mode, depending on your 
work method.  
A TeamBase memory is a (tmx) memory that is created on a server and which receives a copy of the translated 
segments of all the translators that are connected to it in Read/Write mode (see Section 6.2 for more information).  
The TeamBase memory in no way interferes with (the memories in) your project, namely the project memory (with 
the segments you translate) stored in the \omegat subfolder of your local project, and the retrievals and reference 
memories stored in the \tm subfolder of your project. 
You can share your translation — segment by segment in real time (including below 100% matches) — from the 
very beginning by connecting to a TeamBase memory previously created for your project (or that you create 
yourself) and, if you want, to other Teambase memories of other projects that may be ongoing and which may be 
(distantly) related (Read/Write mode).  
But you can also decide to only share your translation later when you consider that it is already sufficiently “good” 
to be of any use to others, but even so you can receive segments translated by others (Read mode). This feature is 
particularly useful if you first do a fast draft translation which you afterwards improve. 
TeamBase memories are bilingual — created for each language pair — and can be accessed by any translator who 
is translating a project with that language combination, be it in one Unit, in the whole Language Department or in 
other Language Departments.  

3 – : You can use DictaTrans or Dragon Dictate as usual.  

4 – : When creating a project, the OmegaT Wizard will do an automatic backup of it to your personal space 
in the H: drive: H:\CAT\OmegaT_Projects. This copy is to be used in case there is a problem/crash in your 
computer and you need to use the backup. 
This backup is automatically updated every 10 minutes — in a background process without interrupting your work 
— for the active project defined in the Project field of the DGT-OT Wizard. Therefore, do not close the 
DGT-OT Wizard after opening a project! 
Furthermore, OT itself does automatic backups of your project every few minutes (saved locally in the \omegat 
subfolder of your project), so the risk of losing any of your work is minimal (I never had any problems!).  

5 – In DGT, the starting point to create (or update) a project with one or several documents is always to use 
the Local copies option in Tradesk to copy to your PC/laptop the original documents to be included in the project.  
By default they are copied to: C:\Users\{your login}\AppData\Local\Local Documents-no backup\DGT\Dossiers. 

6 – : The DGT-OT Wizard will create the OmegaT project in a subfolder of C:\Users\{your 
login}\AppData\Local\DGT\OmegaT_Projects default folder. 

7 – : You can create as many subfolders as you want in the project folder ¾ for 
example, to have monolingual reference documents which can be used for the Search Directory feature or to 
gather any other information, either technical or administrative ¾ but you cannot delete or change the name of 
any of the subfolders that were automatically created for each project. If you do, OT may not work properly.  
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8 – : The DGT-OT Wizard will create the OT project with the original document(s) ¾ wiping 
useless tags in the process (TagWipe) — and the respective memory (tmx) files available for download in Tradesk: 
retrievals, aligned reference documents and machine translation, if any (pre-processed for EN-other languages 
and other selected language pairs). It also includes an IATE extraction to be used as a glossary. 
The DGT-OT Wizard will create the project making TagWipe and segmentation rules project-specific. Therefore, if 
any of them are changed/improved by the IT Unit during the translation of a lengthy project with (many) new 
versions, there will be no change in those rules and therefore you will not have in your project unduly untranslated 
segments. 

9 – : You can update your project at any time during the translation process with new original 
documents and/or aligned reference documents (see Section 6) without the need to create a new project.  
If you update your project with new documents or new versions of documents already in the project, when you 
reopen the project, the 100% segments (including formatting) that you had already translated — which are in your 
project memory in the \omegat subfolder — will be automatically displayed in the Editor pane as translated without 
any other action on your part. 

10 – : If you are translating documents with language combinations which are not 
automatically machine-translated, you will have to request machine translation.  

 Do not forget to select the tmx format. After receiving the MT file by email, copy manually ¾ to the project \mt 
subfolder ¾ the tmx file(s) you receive.  

11 – : You can organise your external 
memories (i.e. memories other than your project memory) by subjects in subfolders of the \tm folder — something 
which may be very useful when you are translating large projects with many reference documents — and give 
them priorities (for instance, EU Treaties have precedence over Regulations and Directives, but these have 
precedence over Communications, Reports, etc.).  
OT reads the memories/subfolders in the \tm folder by alphanumeric order and you can number your documents or 
subfolders to assign priorities. 

 

 
 Screenshot 11 - Fuzzy Matches: the result from the memories in the 1-Main Reference subfolder, another 

segment from the memory of the project and a segment from the 2-Normative Memory 
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12 – : You can also translate multilingual documents in a single project without 
the need to divide the document by source languages, although the project memory - which is by definition 
multilingual - may not be sent to Euramis. 

13 – : You can also use reference memories with the 
same source language but with a target language other than that of your project. That may be useful for 
terminology purposes if there is a previous translation into another language of the same (or of a similar) document 
that can be used as reference (you can give it a penalty if you want). 

14 – OmegaT also allows the use of a 
reference translation memory with the source language identical to the source language of your project and the 
target language of the reference memory different from that of your project, displaying it in the Editor beneath the 
original source segment. 

 Example: You have an LT-PT document to translate and your knowledge of LT is (very) low … but there is already 
a LT-EN translation of the same document. In this case you can use the LT-EN translation memory to have the EN 
relay language displayed in the Editor below the LT original segment. In this way you can see both the LT and EN 
as original segments.

15 – It gives you complete control over the reference memory(ies) you want to use for pre-translation. 
You just have to copy one or more tmx file to the \tm\auto subfolder of your project and the 100% (including tags) 
segments will auto-populate your documents and be highlighted in a background colour to call your attention to the 
fact that they were automatically transferred to your project memory. They will remain so highlighted unless you 
open and modify those segments.  
You can use pre-translate before starting translating a project or at any time in the middle of the process. In the 
latter case, only untranslated segments in your project will be pre-translated. Segments you had already translated 
in your project will remain untouched. 
When you Update a project with a new version of an original, there is no need to pre-translate as your translated 
segments are all in the project memory and are automatically inserted in the new versions (if they are a 100% 
match including tags) without any action on your part. 

16 -  : When you create a project with the DGT-OT Wizard, by default you have an extraction from 
IATE copied to your new project to be used as a read-only glossary for projects with EN as the source language 
and all the other EU languages as target languages. If you don’t want for some reason to have it automatically 
copied to your project, you can untick the box IATE in the DGT-OT Wizard.  

 Furthermore, the first time you create a terminology entry in your project, OT will automatically create a glossary for 
that project, which is the writable glossary. You can also define one — and only one — glossary that you already 
have as your writable glossary, i.e. the glossary in which your new entries will be stored.  
If you have one or more glossaries you want to use in your project, you can just copy it/them to the \glossary 
subfolder of your project to use as read-only. If you want one to be used as the writable glossary, the easiest way is 
just to rename it glossary. For language pairs for which there is not an automatic “filtered” extraction of IATE 
available, you can ask for a full IATE extraction (source term and target term) — which may have 0.5 million or 
more entries — as OmegaT will not lose “speed”. 

17 – You — and your reviser — can do all the revision work using OT, although some 
manipulations will be necessary as the workflow is not automated.  
Both the translator and the reviser can include notes in problematic segments. The segments changed by the 
reviser can be marked with a red background for the translation to check the changes made - if the translator has 
the last word - and  changes introduced can be searched and filtered (by login/date) and displayed with 
track-changes in the target (instead of the source) segments – in the Fuzzy Matches pane – so that the translator 
can easily see the changes made by the reviser.  
However, in OT you cannot accept only part of the changes in a particular segment: it is either the whole revised 
segment or your previous translation … and therefore it may involve some typing.  
In this Quick Guide is presented a standard revision workflow in Section 6.10. 
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1 – : You can only write in the open segment; you cannot write anywhere else in the source or target 
segments of your document(s). There is always a segment open in the OT Editor pane.  

 Segments are validated with <Enter>. OT keeps only the last modified translation of each segment in the project 
memory. 

 When you open a segment you translated before, and which therefore is in your project memory, it will only be 
displayed in the open segment in the Editor. Segments from your project memory are displayed in the Fuzzy 
Matches pane only if they are less than 100% match (including tags). 

2 –  In the Edit menu you have the main editing features with respective shortcuts. 
To move around within the project, you can see the options in the Go To menu.  

 

  

  
Screenshot 12 - The Edit and Go To menus 

 

3 – : The one that matters in terms 
of content is the first percentage. The last one takes into account formatting (Match: <100/100/96%>). 

 

 
Screenshot 13 - Match rates with and without formatting penalty 
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4 – : You can access these DGT applications directly in DGT-OmegaT 
just by clicking on the respective icon.  

5 – : It is really worth exploring the powerful OT Search feature.  
You can search — by exact search, keyword search and regular expressions, strings, whole words and lemmas; 
use the Booleans AND, NOT and AND+NOT; by regular expressions, by author/translator, by date — in source 
or/and target segments in your project (translated and/or untranslated) and/or in the translation memories and/or in 
glossaries and notes. You can also limit the search to a subfolder or a translation memory in the \tm folder. 
For a number of settings, you can also memorize searches to be reused in that session, in that particular project or 
in all projects.  
This is particularly useful for regular expressions. Some are already memorized and saved in the search.tsv file in 
the _CONFIG-PERSONAL subfolder in the OmegaT_Projects folder and you can add others if you want.  
In Section 8 is a list of the regular expressions already memorized in the Search window for search In Source. You 
can copy them to other fields in the Search or in the Search/Replace and Search and Translate windows. They 
are field-dependent. 
In the same window, you can also filter, by those criteria, segments in your project and have them displayed in the 
Editor pane for editing, by clicking on Filter at the bottom of the Search window. 
 

 
Screenshot 14 - Search window with options and results displayed by the order of priority set for translation 

memories 
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 Just for you to have an idea of the kind of results you can get - and how best to use this feature for each particular 

case restricting or broadening your search - see the table below. 
 

 
TERM 

 
EXACT SEARCH + STRING 

 
EXACT SEARCH +  
WHOLE WORDS 

 
EXACT SEARCH + LEMMAS 

 
KEYWORD SEARCH + 

STRINGS 

 
KEYWORD SEARCH + WHOLE 

WORDS 

 
KEYWORD SEARCH + LEMMAS 

 Results No. Results No. Results No Results No Results No Results No. 

withdrawal - withdrawal 
- withdrawals 

102 - withdrawal 88 - withdrawal 
- withdrawals 
- withdraw 
- withdrawing 

192 - withdrawal 
- withdrawals 

102 - withdrawal 88 - withdrawal 
- withdrawals 
- withdraw 
- withdrawing 

192 

arbitration 
panel ruling 

- arbitration panel rulings 
- arbitration panel ruling 

187 - arbitration 
panel ruling 

179 - arbitration panel ruling 
- arbitration panel rulings 
- arbitration panel to rule 
- arbitration panel rules 

250 - arbitration panel ruling 
- arbitration panel rulings 
- arbitration panel to rule 
- arbitration panel rules 
- rulings of the arbitration 
panel 
- Arbitration panel 
decisions and rulings 

419 - arbitration panel ruling 
- arbitration panel ... ruling 
- ruling of the arbitration 
panel 

378 - arbitration panel ruling 
- arbitration panel rulings 
- arbitration panel to rule 
- arbitration panel rules 
- rulings of the arbitration panel 
- Arbitration panel decisions and rulings 
- arbitration panel ..- Rules of Procedure 
- Arbitration panels ...customary rules 

537 

equal 
treatment  

- equal treatment 
- unequal treatment 

48 - equal 
treatment 

45 - equal treatment 45 - equal treatment 
- unequal treatment 
- its treatment is equal 

51 - equal treatment 
- its treatment is equal 

47 - equal treatment 
- equality of treatment 
- treatment is equal 

48 

Screenshot 15 - Search results combining the different settings for the same translation memories in the \tm 
folder 

 
6 - : With Search Directory (in the Edit menu) you can also 

search monolingual documents in the formats accepted by OmegaT (e.g. Office and PDF). This may be very useful 
when you have documents — for example, national legislation, standards — that are relevant to your project.  

 

 
Screenshot 16 - Search in monolingual reference documents 
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7 – : You can do a Replace Interactive (one by one) or a Replace all in all the documents of 
your project using the same options as in Search text (exact search, keyword search, regular expression, case 
sensitive, strings, whole words and lemmas) and “preview” the segments affected before launching the 
replacement operation. 

 
Screenshot 17 - Search displaying matching segments. Option to Replace all or Replace Interactive (one by one) 
8 – : This is a new feature specific to DGT-OT which allows you to Search by some 

criteria and Pre-Translate the resulting segments – either copying source to target or pre-translating them using 
the external memories or machine translation output.  

  This can be very useful when you have documents with hundreds or thousands of segments only with numbers 
that you may want to translate in a batch to have them counted as translated in the statistics … and to 
automatically go to the next segment for translation without stopping in those segments. 

 In the example below, there were almost 5700 segments (out of 18000 segments) which were numbers (positions 
of the EU Combined Nomenclature). With this new feature, in a few seconds, all those segments were 
pre-translated (by copying the source to the target segments) using the regular expression ^[^a-zA-Z]*$b. 

 
Screenshot 18 - Search and Pre-translate with copy of source to target (segments only with numbers) 
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9 – : Footnotes are treated as end notes and are always displayed at the end of each one of 
your documents if it is a multi-document project. There is no visible "link" (besides a non-descriptive tag, if you are 
translating with tags) between them and the respective paragraph. However, they will be correctly displayed in the 
translated documents … as long as you have inserted the respective tag in the relevant segment. 

10 – : You can have notes linked to particular segments in your document which 
are displayed in the Notes pane when that segment is open. When closed, those segments are highlighted with a 
background colour (pink) in the Editor (default). Neither this highlight nor the actual notes will be transferred to the 
Office document.  

 
 

 

Screenshot 19 — Notes display 
 However, you can export all your notes to a file, if you want to discuss them with a colleague/terminologist/reviser. 
 To generate a list of your notes (note, source and target segments), press Ctrl+Shift+F6 or select the wri_notes 

script in the Tools – Scripting menu.  
 

 
Screenshot 20 – List of notes (together with source and target segment), by documents in the project 
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11 –  : 
The first translation of a segment that occurs 2 or more times in one or more documents in a project is 
automatically propagated in all the other repeated segments (non-unique segments) and OT considers it the 
default translation. These segments have the status “translated” and are counted as such in the statistics. 

 You can choose to have the first occurrence of that segment greyed - to call your attention to the fact that it will be 
repeated further on in your project - or to have it greyed only in its second occurrence.  

 
Screenshot 21 — Display of first occurrence of non-unique segments (greyed or not greyed) 

 
Take into consideration that if you change the translation in any one of the segment’s occurrences, all the other 
identical segments (in all the project documents) will automatically and instantaneously be changed, in a 
background operation you don’t see, without any need for confirmation or search, search/replace on our part ... but 
also without any warning.  
So, if you want the translation of a particular instance of a non-unique segment to be different and not changed 
automatically if any other of its occurrences is changed, you can define it as an alternative translation — just by 
clicking on it in the target segment with the mouse right button or selecting it in the Edit menu. This way you 
dissociate it from the other identical source segments by linking it to the previous and next segment.  
For segments with one or more alternative translations, the several translations are displayed in the Multiple 
Translations pane. 

12 – : OT does not allow easily merging or splitting 
segments in the Editor. You can do it, but it is not straightforward.  

 However, you can easily correct/change the original (even merging paragraphs) and update the project with the 
changed document. 

13 – : In OmegaT you can omit formatting that is present in the 
source segment but you cannot add formatting which does not exist in the source segment. You will have to add 
that formatting in the final translated document in its native application. 

14 – :  These are segments that you already translated — and which are therefore in your project 
memory — but which no longer exist in the documents in your project.  
This may happen when you delete — for some reason — a document from your project or when you update a 
project with a new version of one or more documents (and delete the previous version).  
These segments will be displayed in the Fuzzy Matches pane (with their match rate) and identified as “orphans”. 
They are displayed first according to the match rate. 
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15 – : It allows you to complete words from glossaries or auto-text (your own list of abbreviations 
for instance), to add (special/foreign language) characters and also to manage tags by pressing Ctrl+Space and 
cycling through the options with Ctrl+Page Up/Down. You can add entries and you have some customization 
options.  

 

  

  
  

 
 

Screenshot 22 — Auto-complete features 

16 – : The terms/strings with a blue 
linear and bold underline (by default) mean that there is an entry in one of the glossaries (displayed in the 
Glossary pane) of your project. The entries from your writable glossary are displayed first and in bold (in the target 
language) in the Glossary pane. 
By right clicking on the mouse in the term in the Editor, the translation(s) of that term/string will be displayed in a 
dropdown menu. You can select to insert it at the position of the cursor in the target segment in the Editor by 
clicking on it. 
If you do not want to see all those blue underlines, in Optionsð TransTips, unclick Enable TransTips. Then you 
will not see the blue underlines, but the entries will continue to be displayed in the Glossary pane as long as there 
is a glossary in the \glossary subfolder of your project. 

 

 
Screenshot 23 — TransTips and Glossary pane 
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17 – : You can check the spelling in all the documents of your project — with Ctrl+Shift+F7 or 
selecting that option in the Tools menu — and update your dictionaries of ignored or learned words.  
This update is recorded in a sort of “dictionary” files that are language-specific and which are used for all your 
projects. They are saved in the _CONFIG-PERSONAL subfolder in the OmegaT_Projects folder as a txt file and 
you can just edit it as usual, for instance to delete or add lists of words (in batches). 

 
Screenshot 24 — Spellchecker for the all project 

18 – : You can check your documents for a series of possible errors: check for inconsistent 
numbers, shorter target, equal source and target, untranslated segments, etc. with the shortcut Ctrl+Shift+F3. 

 
Screenshot 25 — Quality Check for the whole project — or for a document in the project — with multiple options 
 

19 – : You can view it directly from OmegaT by selecting View Source File in the 
Project menu. 

20 – : There is no (real-time) Preview, but you can easily and quickly view the 
document you are translating directly from OmegaT by selecting View Target File in the Project menu, thereby 
opening it in its native application. 
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Functions and shortcuts: As in most applications, you can use the menus (with the full features) or the shortcuts (for 
many operations). Below are listed some of the most frequently used.  
DGT icons: DGT IT Unit has added some icons for the most common operations, which are self-explanatory (place the 
cursor over them and a text will appear). A new icon has been added to give direct access to the full IATE interface. 

 
        1      2     3      4       5      6       7      8      9    10    11      12    13   14     15    16    17   18    19    20     21 
Function Icon Shortcut Information 
New project 1  Usually created with the DGT-OT Wizard 
Open project 2 Ctrl+O Usually opened with the DGT-OT Wizard 
Reload 3 F5 If you add or delete documents, or add glossaries or dictionaries, to an OT project 

Close project 4 Ctrl+Shift+W Closes the project, but not OmegaT. 
Undo last action 5 Ctrl+Z Only within the open segment 
Redo last action 6 Ctrl+Y Only within the open segment  

Search project 7 Ctrl+F To search terms/strings with many options 

Search and Replace 8 Crtl+K Search/replace all or one by one. 
Go to previous segment 9 Ctrl+P  
Got to next segment 10 Ctrl+N  
Go to next untranslated 
segment 

11 Ctrl+U  

Go to the next  Translated 
segment 

 Ctrl+Shift+U  

Replace with match 12 Ctrl+R Replaces the target segment with the match you select in the Fuzzy Matches pane. 

Insert match 13 Ctrl+I Inserts in the target segment, at the position of the cursor, the match you select in the 
Fuzzy Matches pane. 

Replace with Machine 
Translation 

14 Ctrl+M Copies to the target segment the MT output that is displayed in the MT pane and 
replaces what is there. 

Insert Next Missing Tag  Ctrl+T Inserts the first (or the next) missing source tag in the target segment at the position 
of the cursor. 

Insert missing source tags 15 Ctrl+Shift+T Inserts all the missing source tags in the target segment at the position of the cursor. 

Validate tags 16 Ctrl+Shift+V Shows the list of segments with missing/different/surplus tags in the target segment. 
Clicking on the segment number, OT jumps to that segment in the Editor for editing. 

DocFinder 17 Ctrl+Shift+D Highlight the reference to search and it opens DocFinder 
Quest 18 Ctrl+Shift+Q Highlight the term/string to search and it opens Quest 
IATE 19 Ctrl+Shift+L Direct access to IATE with all its features allowing the creation of new entries. 
Euramis 20 Ctrl+Shift+E Highlight the term/string to search and it opens Euramis 
Quit 21 Ctrl+Shift+Q To quit OmegaT 
Project files  Ctrl+L Displays the list of documents in the project 
Create Translated 
documents 

 Ctrl+D Creates all the translated documents in their native application and stores them in the 
project \target subfolder 

Create Current Translated 
Document 

 Ctrl+Shift+D Creates the translated document open in the Editor in its native application and 
stores it the project \target subfolder 

Open project Folder  Ctrl+Shift+F1 Within OmegaT, to open the project folder in Windows Explorer 
Insert glossary entry  Crtl+Shift+G To create a new glossary entry  
Open writable glossary  Ctrl+Shift+F2 To open the glossary in Notepad++ to change or delete entries. 
Go To Next/Previous Revised 
Segment 

 Ctrl+Shift+X 
Ctrl+Shift+Y 

Used in the revision process for the translator to check the changes made by the 
reviser and having - in the Fuzzy Matches pane - track-changes in target. 

Spellchecker  Ctrl+Shift+F7 To detect spelling mistakes and learn/ignore words in the whole project 
Quality check  Ctrl+Shift+F3  To carry out several levels of quality check 
Auto-completion  Ctrl+space Glossary Entries, Auto-Text Entries, Missing Tags and Character Table 

Auto-completion-cycle  Crtl+Page Down 
or Ctrl space 

Cycle between Glossary Entries, Auto-Text Entries, Missing Tags and Character Table 
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1 – Copy the 2010 Office format already available in Tradesk to your computer.  

2 – Click on the DGT-OT Wizard icon —  — in your desktop (automatically created in the installation of OT) to 
open it. 

 Note: If it is not your first project, select Clear before starting the creation process. 
 

 
Screenshot 26 — Creating a project with the DGT-OT Wizard 

 
3 – Select the source and target languages from the dropdown menu (if not already defined). 
4 – Click on Add — which by default will open a Windows Explorer window in the Dossiers folder — to select the 

original document(s) previously copied to your computer. You have to select them one by one, even if they are in the 
same folder. If they are in different folders, navigate the folder structure to reach and select all the original 
documents. 

5 – In the Windows Explorer window, click on Cancel or press ESC when you have finished selecting the documents. 
6 – By default, the DGT-OT Wizard will give to the new project the number of the first document you added to the list, but 

you can change it — in the Project field — writing a name meaningful to you. 
7 – By default the DGT-OT Wizard will copy to your project an IATE extraction. If you do not want it for some reason, 

untick the IATE option. 
8 – Click on Create and the DGT-OT Wizard will create the OmegaT project.  
9 – Click on Open (which is displayed in green when the project has been created) and it will open that project in 

OmegaT.  
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Note: This is the basic information you need to translate a project. See also Section 3 for a list of main functions, shortcuts and 
icons. 

1 – OT starts by displaying the list of the documents in your project. Click on Close to accept the opening of the first 
segment of the (first) document. You are now ready to start the translation of your first project.  
If you want to translate another document, just do Ctrl+L (or select Project Files in the Project menu) and the list 
will be displayed again and you can select the document you want by double-clicking on it.  
You can also change here the order in which OT displays the documents in your project by highlighting the name of 
a document and clicking on Move First, Move Up, Move Down or Move Last.  

 

 
Screenshot 27 – Project files list 

2 – To see the statistics of your project before beginning your translation, select — in the Tools menu — the option you 
want: Statistics, Match Statistics or Match Statistics per file. Those statistics are stored in the project \omegat 
subfolder. 
Getting Statistics is a fast process, but Match Statistics (per file) can take a while if you have a really big project 
(hundreds of pages). The good thing is that you can do it any time! 

3 -  There are some preferences that you may want to change right away: 
v Menu: Options ð Font:  

    Font type and size: by default Font: Dialog; Size: 18 
v Menu: View: 

    How the segments are displayed/highlighted (only target, also source, identification, etc.) 
v Menu: Options ð View Options: 

    Include the first non-unique segment when marking non-unique menus: By default not activated 
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v Menu Options ð Editing Behaviour Options: 

    Minimal similarity (of automatic insertion of matches): by default 80% 
    Stop at segments with multiple translations: by default not activated 
    Go to Next Untranslated Segment stops when there is at least one alternative translation: by default inactive 
    Validate tags when leaving a segment: by default not activated 
4 – OT displays the first segment to be translated and, by default, if there is a Euramis match above 80% (or a different 

threshold of your choosing), it will be automatically inserted in the segment open for translation.   
If you want to use Machine Translation (which is displayed in the MT pane) even when a Euramis match has been 
automatically inserted in the target segment, just press Ctrl+M to replace it by the MT output.  
If there is no match, OT will display the MT output (by default). You can deactivate the automatic insertion of MT in 
Options ð Editing Behaviour, by unticking Insert Machine Translation. It is here that you can also select the 
Minimal Similarity threshold for the automatic insertion of Fuzzy Matches. 
 

 
Screenshot 28 — The Editing Behaviour Options menu 

 
5 – To insert in the target segment an Euramis match other than the first (higher) match displayed in bold in the Fuzzy 

Matches pane, position the cursor on the Fuzzy Match segment you want to use, double click on it (which will turn 
to bold as the selected segment) and use the shortcuts Ctrl+R or Ctrl+I. 

 You can also right click on the mouse and choose the option you want from the drop down menu: To Insert Match 
into Translation or To Replace Translation with Match or press Ctrl+{number of fuzzy match} followed by 
Ctrl+R or Ctrl+{number of fuzzy match} followed by click on the icon Replace with Match 
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 It is also in here that you can see, when there are some/many repetitions between documents, what are the 

documents in your project that have a particular non-unique segment. 
 

 
Screenshot 29 — List of documents in the project with the same non-unique segment (in this case 9 documents) 

and options to insert or replace translation in Editor. 
 
6 – Translate/correct your first segment and press Enter to validate it and to open the next segment for translation. 
7 – If you want to go to another segment (far) above or below, just scroll/go to that segment and double click on it to 

open it for translation. OT will save the previous segment to the project memory and open the new selected 
segment.  

8 – You can copy/paste, drag/drop between the Fuzzy Matches, Search and Editor panes and from applications 
outside OT.  

9 – To use DocFinder, Quest, Euramis or IATE, just highlight the term/string/OJ reference you want to search and 
click on the icons or use the shortcuts (Ctlr+Shift+F, Ctlr+Shift+Q, Ctlr+Shift+E or Ctrl+Shift+L, respectively). 

10 – To insert a tag, position the cursor where you want the tag to be inserted and press Ctrl+T. OT will insert the first or 
next missing tag in that position. You can also right-click the mouse and choose the tag you want from the 
dropdown menu.  

 Other options are: pressing Ctrl+Space to use the Auto-Completion feature to choose the tags in the dropdown 
menu (this is especially interesting for paired tags (bold, underline, italics)), clicking on Icon 15 to insert all missing 
tags at the position of the cursor or copy/paste or drag and drop the tag(s) from the source segment. 

 If, in the open target segment in the Editor you have a match with tags and you want to get rid of the tags for some 
reason, press Ctrl+Shift+F5 (or select Strip tags in the Tools menu) to have the target segment cleaned of tags 
so that you can edit a “clean” segment … probably with different tags. 

11 – To search terms/strings in the project and/or the reference translation memories and/or glossaries and or/notes, 
highlight them in the Editor pane, press Ctrl+F and press Enter to accept the defaults ¾ or select the setting(s) 
you want in the Search window. OT will search for terms according to the settings. There are many options worth 
exploring.  

12 – You can Search / Replace all or one by one (Replace Interactive) by doing Ctrl+K or clicking on Search and 
Replace in the Edit menu.  

  



DGT-OMEGAT AND ITS WIZARD — Quick Guide — MJM — April  2015 — DGT-OmegaT-3.1.2_3+DGT Extensions 2.3. beta update 5 
 

25 
 

 
13 – To create a glossary entry, highlight the source term you want and press Ctrl+Shift+G (or go to the Edit menu and 

click on Create Glossary Entry) and fill in at least the first 2 of the 3 fields available (source term, target term and 
comments).  

 
Screenshot 30 — Creating a new Glossary Entry 

If it is the first entry you create in that project — and you have no previous writable glossary in the \glossary folder 
of your project — OT will automatically create a glossary for the project.  
If you want to delete or change an entry in your writable glossary, press Ctrl+Shift+F2 (or select that option in the 
Tools menu) to open the glossary in Notepad++ for editing. 

14 – The terms/strings with a blue linear and bold underline in the open segment in the Editor mean that there is an 
entry in one of the glossaries in the \glossary folder of your project (which are displayed in the Glossary pane). By 
right-clicking the mouse, the translation(s) of that term/string will be displayed in a dropdown menu.  
You can select to insert one of them at the position of the cursor in your target segment by clicking on it. Terms 
displayed in bold belong to the project glossary. 

15 – To use the Auto-Completion feature, press Ctrl+space and cycle through the options by doing Ctrl+Page 
Down/Page Up to select the option you want.  
To add a new entry for auto-text (abbreviation), select Options ð Auto-completion ð  Auto-text and add your 
new entry. To add a character to the character table, select Options ð Auto-completion ð  Character table. 

16 – After finishing your translation, or at any time during the translation process, click on the icon 16 (Validate tags) or 
press Ctrl+Shift+V and check if OT detected anything wrong/missing. By clicking on the number of the segment in 
the window that is displayed on the left, OT will jump to the segment in question and open it in the Editor pane and 
you can correct it if needed.  
The Validate tags check is sometimes overcautious. There are tags that you may ignore... but others not!  

 
Screenshot 31 — Tags validation by document or for the whole project 

If there is a tag at the very beginning or end of a segment, or tags before and after a full stop in segments that 
should have been split, don’t even think of what they mean, just insert them, in the same position, in the target 
segment or otherwise it may happen that your translated documents will not be generated. 



DGT-OMEGAT AND ITS WIZARD — Quick Guide — MJM — April  2015 — DGT-OmegaT-3.1.2_3+DGT Extensions 2.3. beta update 5 
 

26 
 

 
Concerning paired tags — for italics, bold, underline — if you insert only one of them, your document will probably 
not be generated as expected. However, if you do not insert both, the only problem is that the particular word/string 
will not have formatting in its native application. 
Concerning footnotes, if you do not insert the tag in the target segment, the footnote will not appear in the 
translated document in its native application, although you have translated it. So, be careful! 
However, if you are working with Remove Tags activated, the footnotes will be in the right place at the bottom of 
the right page and the number of the footnote will be at the end of the right paragraph … but maybe not in the right 
position. You will have to check and, if necessary, change it in the translated document in its native application. 

17 – You can do the Spellchecking in your whole project by clicking on Ctrl+Shift+F7 or selecting it in the Tools menu. 
You can also add learned or ignored words one by one by right clicking on the mouse and selecting Ignore all or 
Add to dictionary. 

18 – You can do a quality check of your project — QA Check Rules — by clicking on Ctrl+Shift+F3 or selecting it in the 
Tools menu. You can choose the type of “errors” you want to detect by ticking/unticking each box. 

19 - If you want to view the document you are currently translating, press Ctrl+G and OT will generate the translated 
document and display it in its native application. 

 If you have one or more translated documents open in their native application, the operation cannot be completed. 
So, don’t forget to close all those documents before generating translated documents with this shortcut or the 
Ctrl+D and Ctrl+Shift+D shortcuts. 

20 – To create the translated document(s) in their native application(s), press Ctrl+D to generate all the target 
documents or Ctrl+Shift+D  to generate only the document you are working on. They are generated in the project 
\target subfolder.  
It is better to do Validate tags before creating one or more translated documents. But if you don’t, OT will generate 
them — even if without some formatting — except if essential tags are missing (see point 16 above). If so, correct 
them and generate the document(s) again. 

21 – You can generate the formatted document as many times as you want, taking into consideration that any changes 
you make directly (formatting or content) in the generated target document will not be transferred to the OT project 
memory.  

22 – Every time you repeat the Create (Current) Translated Document(s) command, OT will replace — in the \target 
subfolder — the previously translated document(s) with the updated one(s). So don't make any changes in the 
document(s) in their native application unless you are sure you won't use OT again for the translation of that 
particular document. 

23 – If you are working in a project with a (large) number of documents and/or with different deadlines — and you make 
changes in it/them directly — it may be “wise” to create a new subfolder in your project and save your document(s) 
to that subfolder so that they are not replaced by any subsequent creation of translated documents.  
It is not advised to make changes in a document in its target application without uploading it to Tradesk first. 

24 - If your reviser wants to use OmegaT, see Section 6.10 for a standard revision workflow.  
25 – To copy the translated document(s) to Tradesk — at any moment during the translation or to be sent to the 

requester — for the moment you have to upload the translated document(s) using the Tradesk Upload function.  
The translated document(s) are in the project subfolder \target of your project which is in System  (C:) — Users — 
{your login} — AppData — Local — DGT — OmegaT_Projects. Make it a Favourite! 

26 -  If you finished your translation (revision included, if any) using OmegaT, export the individual memory of the 
document(s) in your project in a format accepted by Euramis by pressing Ctrl+Shit+F8 (or select the option Create 
Euramis Export from the Tools menu).  

 For the moment, you will have to send the memories so generated - saved in the project \euramis subfolder - 
manually to Euramis via the Euramis interface, selecting the individual memory(ies) to be sent to Euramis in the 
above mentioned subfolder. 
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The OmegaT Project Wizard helps you to quickly and easily manage your OmegaT projects — creating, updating and 
modifying them — by interfacing with Tradesk, Windows Explorer and OmegaT.  
The starting point to create (or update) a project with one or several documents (with the same or different dossier 
numbers) is always to use the Local copies option in Tradesk to copy to your PC/laptop the original documents to be 
included in the project.  
By default they are copied to the C:\Users\{your login}\AppData\Local\Local Documents — no 
backup\DGT\Dossiers folder).  
To manage your project, you can click on the buttons or use the shortcuts (ALT + character underlined, for example 
ALT+A). 

Note:  If the first character of each option is not underlined, just click on Alt to activate the shortcuts. 

1 – Click on the DGT-OT Wizard icon —  — in your desktop, if it is not open.  If OmegaT is open, close it. 
2 – If a previous project is active (with its name in the Project field), click on Clear before creating the new project. 
3 – Define the source and target languages (if necessary). 
4 – Click on Add — which will open a Windows Explorer window — to select the original document(s) that you 

previously copied to your computer. In multi-document projects, repeat the operation to add them one by one. Click 
on Esc, or Cancel in Windows Explorer, when you have finished selecting documents. 

5 – By default, the name of the new project will be the name of the first document added and it is displayed in the 
Project field, but you can change it to whatever you wish (for example, Budget2015).  

6 – By default a filtered IATE extraction will be automatically copied to your project for projects with EN as source 
language and all the other EU languages as target languages.  

 If you don’t want it for any reason, you can untick the option IATE. 
7 – Click on Create.  
8 – The Wizard will create the OmegaT project in a subfolder of the OmegaT_Projects default folder (System (C:) — 

Users — {your login} — AppData — Local — DGT — OmegaT_Projects) with the original(s) you selected — 
wiped of useless tags (TagWipe) if they are Word documents — and the respective memory files and MT output 
available in Tradesk.  
The DGT-OT Wizard assumes that, in the majority of cases, you will want all the memories that are available in 
Tradesk.  
As there are no speed or capacity problems, you can afford not to be selective. But if you want you can afterwards 
delete the memory files you don’t/no longer want in your project. 

9 – If you are translating a project with a language combination for which Machine Translation is not automatically 
pre-processed: 

a) Request machine translation as explained in Section 2.2.10 and you will receive the MT file by email.  
b) Click on Browse and open the \mt subfolder. 
c) Copy the MT file received from MT@EC to this folder. 

10 – Click on Open and it will open OmegaT and that particular project. 
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For documents in a project that are translated by two or more translators, it is important to be able to share memories in 
real time. With OmegaT, the sharing is done using TeamBase, a DGT in-house application which is managed via the 
DGT-OT Wizard. 
A TeamBase memory is a bilingual memory that is created on a server and which receives — in real time —  a copy of 
each translated segment validated by the translators connected to it in Read/Write mode.  
You can connect to a TeamBase memory in Read mode only — in which case you receive segments from other 
colleagues, but do not send your (validated) segments — or in Read/Write mode — in which case you receive segments 
from your colleagues connected to the same TeamBase in Read/Write mode and also send your segments to share with 
them.  
Usually the “coordinator” of the project will create a TeamBase memory for your language pair to which others can 
connect. That translator is considered the “owner” of that TeamBase memory and the only one who can delete it 
(besides the IT Unit, of course). 
The TeamBase memory is hosted in a server and it interferes in no way with (the memories of) your project which is in 
your computer. Each translator continues to have its own local project and it will remain “untouched”. You will only see — 
in the Fuzzy Matches pane — segments coming from TeamBase identified with the usual attributes plus “Teambase” at 
the beginning.   
The TeamBase memory is empty when created and will only have a copy — automatically done in real time — of the 
segments that you and other translators open and validate while being connected to TeamBase in Read/Write mode.  
It is the validation of each segment in OmegaT (with Return) — either of a new translated segment or of a modified or 
unmodified one — that triggers the copy of that segment to the TeamBase memory (besides storing it locally in your 
project memory, of course). So, the segments you – and your colleagues — translate in Read mode or disconnected 
are not (ever) sent to the TeamBase memory. 
If you are connected in Read/Write mode and you modify a segment that is already in the TeamBase memory, the 
previous translation will be replaced by the new one, i.e., the TeamBase memory only keeps the last translation of a 
unique segment with the same translator’s login.  
So, in the translation of a project, you can modify any segment several times and – in the TeamBase memory – there will 
only be your last translation of each unique segment, which will be displayed in the Fuzzy Matches pane in the other 
translators’ projects and in your own.   
You can connect to one or more Teambase memories as there may be several projects ongoing that may be (distantly) 
related. If you want to connect to other TeamBase memoriy(es), you can do it but only in Read mode. Only the first 
selected memory can be in Read/Write mode. 
In the TeamBase window you have 3 columns which display:  
v All the TeamBase memories available for your language pair, in the left column.  

Here you can connect to a TeamBase in the desired connection mode (the mode displayed in the button) or 
change its connection mode and reconnect again; 

v The memory(ies), if any, to which you are connected, in the middle column.  
Here you can check (by highlighting the name of the memory) in what mode you are connected and it is also 
here that you disconnect from the highlighted memory;  

v The memories, if any, of which you are the owner (in the right column).  
When you close a particular project and later reopen it, you will remain connected or unconnected to TeamBase as you 
were before you closed the last session with that project. Check if you want to change anything.  
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To connect to a TeamBase memory already created: 
1 – In the DGT-OT Wizard, select the project you previously created and with which you want to use Teambase, if it is 

not the active project. 
2 – Click on TeamBase in the DGT-OT Wizard. 
3 – Select a memory from the list displayed in the left column.  
4 – Select the mode in which you want to work: Read (receive) or Read/Write (receive/send). 
5 – Click on Connect to Shared. 
 The TeamBase window will close automatically and you can start/continue working on your project. 
 

To create a new TeamBase memory you have first to create the project using the DGT-OT Wizard, if you haven’t done it 
yet. 
1 – In the DGT-OT Wizard, select the project with which you want to use Teambase if it is not the active project. 
2 – The name of your project will be automatically inserted in the field at the bottom of the Available Shared 

Memories column. 
 If you want you can change its name to whatever is meaningful to you and your colleagues (Example: 

EurSemester2015)  
3 – To work on that project, select the mode in which you want to connect: Read (receive) or Read/Write (receive and 

send). 
 The other translators may choose, at different times, to work in either mode or disconnected. 
4 – Click on Connect to Shared. 
 The TeamBase window will close automatically and you can start/continue working on your project. 

If you want to change from Read/Write to Read only — or vice-versa: 
1 – With the relevant project selected in the DGT-OT Wizard, click on TeamBase 
2 – In the middle column, click on the name of the memory you are sharing 
3 – Click on the button Read/Write or Read to change the mode.  
4 – Close the TeamBase window. 
5 – You can resume your work. 
If you change from Read/Write to Read, you will no longer be sending the segments you translate from then on to that 
TeamBase memory, but you will continue to receive segments from others.  
If you change from Read to Read/Write you will start sending the segments you validate after changing the exchanging 
mode. The segments you may have translated in Read mode or disconnected will not be sent to the TeamBase 
memory. 
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If you want you can disconnect from a Teambase memory: 
1 – With the project selected in the DGT-OT Wizard, click on TeamBase 
2 – Select the name of the memory in the middle column 
3 – Click on Disconnect From Shared.  
You will no longer receive nor send segments from/to that memory.  
If you are connected to more than one TeamBase memory, the other(s) will remain connected. If you want to disconnect 
from other(s)/all, you have to disconnect one by one. 

A TeamBase memory is a temporary memory to be used in an ongoing project. When the project is finished and all the 
final translation memories have been sent to Euramis, there is usually no need to keep it. 
Only the “owner” of the TeamBase memory (or the IT Unit) can delete the memory. 
To delete a memory you own: 
1 – With the relevant project selected on the DGT-OT Wizard, click on TeamBase. 
2 – Click on the name of the memory you own and want to delete in the column Shared memories I own (the right 

column).  
3 – Click on Delete shared memory 
 

You can give priority to memories or groups of memories (for instance, Financial Regulation legislation, Horizon 2020 
legislation) in an easy way so that: 

Ø In the Fuzzy Matches window, the matches are displayed by order of match rate (in ascending order) and, 
with identical match rate, by the order of preference you gave to those memories or subfolders.  

Ø In the Search window, the segments are displayed by the order in which the tmx files were ranked.  
To organise your memories: 
1 – You don’t need to close OmegaT if you have it open with that particular project. 
2 – In the DGT-OT Wizard, click on Browse and select the \tm subfolder of the active project you want to manage.  
 There you have all the translation memories that were automatically copied to your project by the DGT-OT Wizard 

when the project was created or updated.  
3 – Using Windows Explorer features, you can rename tmx files (for example 22013D0743-EN_EN-PT-AL, 

32013R1290-EN_EN-PT-AL) to rank them.  
 Or, even better, you can create subfolders in the \tm subfolder of the project — to where you can copy or drag and 

drop the tmx files you want to use as reference — and give those subfolders the name and priority you want (for 
example 1-Horizon2020, 2-Financial Regulation). 

 You can also just copy/paste folders you have in your computer with thematic translation memories and you can 
change at any time the priority given to those memories or subfolders without the need to do Reload. 

4 – You can resume your work if that project was open. If not, click on Open in the DGT-OT Wizard.   
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To give a penalty to one or more memories, you can create subfolders with names like "penalty-xxx" where xxx is a 
number from 0 to 100.   
1 – You don’t need to close OmegaT if you have it open with that particular project. 
2 – In the DGT-OT Wizard, click on Browse and select the \tm subfolder of the active project.  
3 – Create a new subfolder with a name indicating the penalty you want (for example: a subfolder named penalty-30).  
4 – Copy the translation memory file(s) to it.  
5 – You can resume your work if that project was open. If not, click on Open in the DGT-OT Wizard.   
A percentage penalty will be applied to the matches of all translation memory files within such subfolder. For instance, a 
76/78/82% match will be transformed into a 46/48/52% match in the case of a 30% penalty.  

If you don’t already have a glossary that you want to use in the project, when you first create a glossary entry, OT will 
automatically create a glossary for the project (the writable glossary) which is stored in the \glossary subfolder of that 
project.  
If you have personal/Unit/Department glossaries that you would like to use in your project, you can adapt them to be 
used in OT.  
The format OT accepts is the following simple txt file with 3 fields separated by tabs and ended by a carriage return (the 
last field is optional):  

 <tab> <tab> <Return> 3rd field with whatever you like or empty
 

  
Screenshot 32 — OT glossary opened in Notepad++ for editing 

Save it as a plain text (txt), UTF-8 file. 
If you want a glossary to be your writable glossary — the glossary where you will create new entries for that project — 
the easiest way is just to (re)name it “glossary”.  
To add one or more glossaries to your project: 
1 – There is no need to close OmegaT or that project if it is open.  
2 – Click on Browse and select the \glossary subfolder.  
3 – Copy/paste the glossary(ies) to that subfolder.  
4 – In OmegaT, do Reload (F5) and resume your work. 
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In the DGT-OT Wizard, the approach taken was that, in the huge majority of cases, you will want all the memories that 
are available in Tradesk to be copied to your project and therefore you are not asked what memories to import. The 
DGT-OT Wizard just imports all the (tmx) memory files in the \pret folder related to the language pair of your project.  
However, there may be projects in which you prefer, for some reason, not to use certain memories. So, to delete 
memories:   
1 – You don’t need to close OmegaT if you have it open with that particular project. 
2 – In the DGT-OT Wizard, click on Browse and select the \tm subfolder of the active project.  
3 – Delete the tmx files you don’t (any longer) want to have in the project. 
4 – You can resume your work if that project was open. If not, click on Open in the DGT-OT Wizard.   

You can add at any time new documents or versions of documents to a project in a simple way.  
The segments you already translated are stored in the project memory and are automatically inserted in the new 
document/version of your document(s) if there is a 100% match (including tags), without any action on your part. 
1 – If OmegaT is open, close it. Select the project to be updated by clicking on Select, if it is not the active project.  
2 – Check that the source and target languages are correct. If not, select the correct ones. 
3 – Click on Add — which will open a Windows Explorer window — to select the original document(s) that you 

previously copied to your computer. In multi-document projects, repeat the operation to add them one by one.  
4 – Click on Cancel in Windows Explorer, or press Esc, when you have finished selecting your documents. 
5 – If new version(s) of existing document(s) are added, in the DGT-OT Wizard click on Browse, select the \source 

subfolder and delete the previous version of the original document(s) if no longer needed (usual situation).  
6 – Click on Update. 
7 – Click on Open when the update is finished and the DGT-OT Wizard will open OmegaT and that particular project.  

If you don’t want to add any new documents, but just add aligned reference memories that you have requested via 
Tradesk (available legislation) or via Euramis (with copy to \pret) after creating the project, the procedure is basically 
the same as described in point 6.7.  
Based on the document(s) you add, OT will copy any new memories in \pret related to the defined document(s).  
1 – If OmegaT is open, close it. Select the project to be updated by clicking on Select, if it is not the active project, and 

check the source and target languages.  
2 – Click on Add — which will open a Windows Explorer window — to select the original document(s) that you had 

previously copied to your computer and which are related to the new aligned reference memories you want to copy 
from Tradesk to your project. 

 If the memories relate to documents which are part of a single dossier, you just have to add one of the documents 
in that dossier and the DGT-OT Wizard will copy all the new memories to the project. If it relates to different 
dossiers, select one document from each dossier. 

3 – Click on Cancel in Windows Explorer, or press Esc, when you have finished selecting the documents to which 
those memories refer to.  

4 – Click on Update. 
5 – Click on Open when the update is finished and the DGT-OT Wizard will open OmegaT and that particular project. 
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If you have thematic or reference memories in your computer — for instance, from a previous project — that you want to 
use in a project, you can easily do it. 
1 – There is no need to close OmegaT or that project if it is open. Select the project to be updated by clicking on 

Select, if it is not the active project, checking that the source and target languages are correct. 
2 – Click on Browse and select the \tm subfolder of that project.  
3 – Copy to it the memory files in your computer to be included in that project with copy/paste or drag & drop (from 

another Windows Explorer window) and, if you want, organise them as explained in Section 6.3.  
4 – You can resume your work if that project was open. If not, click on Open in the DGT-OT Wizard.   
 

If you want to copy the Office translated documents (even during the translation process) to make them available to 
everybody in Tradesk or to finalize them and send them to the requester: 
1 – Check that you have no translated documents from that project open in their native applications. 
2 - Do Create (Current) Translated Document(s) (Ctrl+(Shift+)D in OmegaT.  
3 - In Tradesk, Upload of the document(s) you want from the project \target subfolder. 

If the translation is finished (revision included) using OmegaT, now you can already send the individual memory(ies) to 
Euramis with the relevant attributes. 
For the moment, you must do it manually: 
1 – Generate the memory(ies) to be sent to Euramis by clicking on Crtl+Shift+F8 (or Tools – Scripting – Create 

Euramis Export). That memory is saved in the \euramis subfolder of your project.  
2 - Open the Euramis interface and select the individual memory(ies) to be sent to Euramis in the above mentioned 

subfolder. 
To see to which Euramis Memory are your particular document(s) to be saved, see the Euramis ð Statistics & 
Managers ð List to see Where to Save a document from a given DG, service or Cabinet 

3 – You will receive an email with the confirmation that the memory of your document(s) has been saved. 
 

1 – Automatic backups are made when a project is created — and they are updated every 10 minutes — to the 
H:\CAT\OmegaT-Projects folder, which has automatic backups by the IT Unit.  

 In case of problems in your computer, the project backup folder can be copied to another computer or your repaired 
computer and be used without any conversion. You just open the project with OmegaT (Wizard) and resume your 
work.  

2 – Manual backups — By clicking on Backup in the DGT-OT Wizard, you can manually update the backup any time 
you want. 

  



DGT-OMEGAT AND ITS WIZARD — Quick Guide — MJM — April  2015 — DGT-OmegaT-3.1.2_3+DGT Extensions 2.3. beta update 5 
 

34 
 

 

If your reviser wants to use OT to do the revision of your document(s) - and of course if you have done all your 
translation work using OT - you can do it but with some manipulations on your part as there is no automated revision 
workflow for the moment.  
Take into consideration that, in OT, there are no track-changes in the (open or closed) target segment(s) displayed in the 
Editor. There are only track-changes in the segments displayed in the Fuzzy Matches pane which, in the revision stage, 
are from the “draft” translation that is being revised and eventually from other external memories. 
As it is possible to display track-changes in the target segments too, the translator who is checking the changes made by 
the reviser - to accept them or not - can see the track-changes in the target in the Fuzzy Matches pane for the segment 
that is open in the Editor. 
Also take into consideration that, if you – as the translator - have the last word, you cannot accept some of the reviser’s 
changes and reject others in a particular segment. You can either accept all the changes made by the reviser or change 
manually the ones you don’t accept. Or you can also reinsert your initial translation (from the Fuzzy Matches pane) and 
do the partial changes to your initial translation manually. 
Here is presented a standard workflow of a (single or multidocument) project that is translated by 1 translator and 
revised by 1 reviser and the whole project is sent for revision.   
 

In the original translation project: 
1 - Close any generated translated documents that may be open in their native applications. 
2 –  Generate the translated document(s) with Ctrl+D. If your reviser wants the documents printed too, print them. 
3 - Copy the translated document(s) to Tradesk (using Tradesk Upload feature) so that they are available there to the 

reviser … and to everybody else. 
4 - You can also export any notes you may have introduced with the command Ctrl+Shift+F6 (Tools - 6. Write Notes 

to File script) which will be saved in the \script_output folder generated in your project folder when you use this 
feature.  
This way you can give the notes to the reviser in paper or electronic format. Anyhow, they will be displayed when 
the reviser opens a particular segment which has a note. 

5 -  Generate the project translation memory(ies) to be used for revision by pressing Ctrl+Shift+F9 (or Tools - 9 - 
Create OmegaT Export) and selecting (all) the document(s) in the window that is displayed.  
OT will generate individual memory files (if it is a multi-document project) - with notes and alternative translations, if 
any (but without orphan segments) - to the project \export-omegat folder. 

6 -  With Ctrl+C and Ctrl+V, do a copy of your project to the same folder and rename it (for instance {name-of-the-
project}-FOR-REVISION). This way, your original project will remain intact and you can always reuse it if you want. 

In the copy of the project for revision: 
7 -  In Windows Explorer or via the DGT-OT Wizard, open the project folder. 
8 - Copy the memories generated in the \export-omegat folder to the \tm\auto folder.  

If you want (it’s optional) rename it/them (for instance, {name-of-the-document}-DRAFT) so that there is no doubt 
that these are memories before revision.  

9 - Open the \omegat folder and delete all the memories there. Usually there will be a project_save.tmx file and 
several backups (example: project_save.tmx.201503121120.bak or project_save.tmx.bak). Leave the other files 
in this folder as they are. 

10 -  If you want you can delete files - translation memories (retrievals or reference alignments) in the \tm folder, MT 
output in the \mt folder or any other files - that you consider of no interest to the reviser. 

11 -  Copy this project to a location on a server that you have agreed with your reviser or which is the location used in 
your Unit/Language Department to exchange projects. 

12 - Inform the reviser that the project is ready for revision and indicate the location.  
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1 –  In Windows Explorer, copy to the OmegaT_Projects folder the project for revision prepared by the translator that 
was copied to the server. 

2 - Open the project as usual via the DGT-OT Wizard to have automatic backups every 10 minutes. 
3 - The process is the same as in translation mode. The only difference is that the documents are considered 

pre-translated and the segments are displayed in the Editor with an orange background to indicate that they were 
“auto-populated”. 

4 -  You can open all the segments or just the ones you want to change (View mode with Display Source Segments 
activated). 

 Only the segments that you open and change will be identified with your login and will no longer be displayed with 
an orange background. The others will remain with the login of the translator and with the orange background. 

5 - In the Fuzzy Matches pane, you will see first the segment from the files in the \tm\auto folder (the “draft” 
translation) and after them the segments from external memories, if any.  

 As OmegaT only keeps the last modified translation in the project memory, this way you can always recheck the 
segments you revised against the initial translation displayed in the Fuzzy Matches pane. 

6 - You can see the Notes that the translator may have written and you can “communicate” with the translator writing 
your comment/answer or creating new notes.  

7 - At the end you can check the segments you revised just by scrolling in the Editor and looking at the segments that 
are no longer with an orange background and eventually opening them and changing them again.  

8 - If you want to check the changes you have made with track-changes, you can - in Options ð External TMX 
Options menu – tick the box View diff in target. Of course, you will have to open the segment to see the 
track-changes displayed in the target segment(s) in the Fuzzy Matches pane. 

  If you do that, don’t forget – after finishing the revision – to change again this setting if you are afterwards going to 
do translation (and not revision) work. 

9 - If you also want to quickly check the changes you have made and not scroll in the Editor if it is a big project - just 
filter those segments by doing a Search by Regular Expressions, writing a dot (“.”) in the field In translation, your 
login in the field Translator and selecting Memory.  

  Don’t forget to tick the box in those 2 fields (and to untick them when you no longer need it). 
 Those segments are displayed in the Search pane and you can filter them for editing in the Editor or just click on 

the number of a particular segment to open it in the Editor. 
 

 
Screenshot 33 – Searching and Filtering - by the reviser- of the revised segments, by login of the reviser (in this 

example machame-REVISOR) 
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10 - When you finish the revision, rename the project (for instance, {name-of-the-project-REVISED). 
11 -  If you have the last word and you release the translation, just follow the normal procedure to send translated 

documents to Tradesk and translated document memories to Euramis. 
12 - If the revised translation is to be finalized by the translator - or if you want to give the revised translation to the 

translator for information purposes only - copy the whole project to the same server location and inform the 
translator. 

If you are the translator and you have the last word:  
1 - Copy to your computer the copy of the revised project from the server location. 
2 - Open the project as usual via the DGT-OmegaT Wizard to have automatic backups. 
3 - To easily see the segments that have been changed by the reviser, in the View menu activate Mark Revised 

Segments to have those segments marked with a red background. To see the changes made by the reviser, use 
the feature Go To Next/Previous Revised Segment (View menu) or the shortcuts. 
What OT does is go to and open the segment that is identified with the login of another user, in this case the 
reviser’s login. You can also do as explained in point 9 of the previous subsection and use the Search and Filter 
features. 
 

 
 

Screenshot 34 – Viewing the changes made by the reviser with the Mark Revised Segments feature 
 

4 –  Either accept the changes made by the reviser, reinsert your own translation from the Fuzzy Matches pane and/or 
do partial changes to any of them.   

5 - To finalize your project just follow the normal procedure to send translated documents to Tradesk and translated 
document memories to Euramis. 
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OmegaT itself has basic management features and in DGT the management of projects is done via the DGT-OT Wizard.  
But when you have confidential documents, you cannot use it and you will have to create the project directly in OmegaT. 
In that case, you will not have: 
1  – Automatic backups to the H:drive, so take appropriate measures concerning backups. 
2 – Your documents, if they are docx, will not be automatically wiped of useless tags (the “tag soup”) and you will 

have to use the manual TagWipe available in your Desktop or work in OmegaT with the Remove Tags option (in 
the Project – Properties menu) activated if your document(s) have too many useless tags. 

You can create the project in your computer or in a USB key, depending on the security instructions.  
With the Project menu (or with shortcuts or the icon) you can create a project directly in OmegaT. 

Screenshot 35 — OmegaT Project menu 

1 – In the DGT-OT Wizard, open any project to open OmegaT as in DGT the access to OmegaT is done via the 
DGT-OT Wizard. 

2  – Close the DGT-OT Wizard 
3  – In OmegaT, close that project (Edit – Close)  
4 – Create a new project (Project – Create) – anywhere you want — and give it the name you want. 
5 – If it is a docx, use the manual TagWipe if you want or work with Remove Tags activated (in the Properties menu) 
6 – In the Project menu, select Import Source Files to copy the original documents to your project 
7 – If you have external memories, copy them to the project \tm subfolder using Windows Explorer.  
8 – If you have MT files, create a \mt subfolder (which is not there if you create a project directly in OT) and copy those 

files to it.  
9 – You can work normally with OmegaT ... but there will be no automatic backups, no automatic updates, etc.  
 

To update or modify a project directly in OmegaT, it is, mutatis mutandis, as explained in this Quick Guide... but without 
the help of the DGT-OT Wizard to interface with Tradesk and so you will have to do those operations manually.  
You can access the open project via the Tools menu, under Scripting — Project Folder and manage your project 
directly via Windows Explorer. 
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The Regular Expressions below are memorized in the Search window for the In Source field. They will be displayed 
when the Expression mode is set to Regular Expressions. 
As the Memorize feature is field-dependent, write/copy the regular expressions you need to other fields in the Search 
window or in the Search/Replace or Search and Translate windows. If you want to include a description, use the “|” 
followed by the RegEx (like those memorised here), making sure that it is not a string that is likely to happen in any text. 
To memorize Regular Expressions, just write or copy the RegEx you want in the field you want, click on Memorize for 
that field and select if you want to save it for the session, the project or all projects. 

Regular expression Memorized description What it finds 
[\d]{1,},[\d]{1,2} 1-2DECIMALScomma Decimal numbers  (2 decimal places) separated by comma (,) 

[\d]{1,}\.[\d]{1,2} 1-2DECIMALSdot Decimal numbers (2 decimal places) separated by dot (.) 

[\d]{1,}\.[\d]{1,2}% 1-2DECIMALSdotPERCENTAGE Decimal numbers (2 decimal places) separated by dot (.) immediately 
followed by % 

[\d]{1,2}[\.-\/][\d]{1,2}[\.-
\/][\d]{4} 

DATES Dates in following formats: (D)D.MM.YYYY, (D)D-MM-YYYY and 
(D)D/MM/YYYY 
At the beginning of segment :  add ^ at the beginning, e.g. ^[\d]{1,2}[\.-
\/][\d]{1,2}[\.-\/][\d]{4} 
At the end of segment :  add $ at the end, e.g. [\d]{1,2}[\.-\/][\d]{1,2}[\.-
\/][\d]{4}$ 

[\d]+ DIGITSall Any number of digits 
W/ NOT ticked: only segments without digits 
W/ "Full segment" activated: segments with digits only (i.e. no spaces, 
punctuation, symbols or letters) 
W/ "Partial segment" activated: segments which possess at least one digit 

[\d]{1,}% DIGITSpercentages Digit(s) immediately followed by %, e.g. 5% 
With a space before %: [\d]{1,}\s% (\s caters for all kinds of spaces and tab) 

[A-Za-z]+ LETTERSall Any number of upper- and lowercase letters (i.e. no spaces, digits 
punctuation, symbols or letters from other alphabets) 
W/ NOT ticked: only segments without any letters 
W/ "Full segment" activated: segments with letters only (i.e. no spaces, 
punctuation, symbols or letters from other alphabets) 
W/ "Partial segment" activated: segments which possess at least one letter 

^\([a-zA-Z]{1,4}\) LETTERSstartBRACKETS Segment starting with characters (case-insensitive) in brackets, e.g. (a), (i), 
(vi) or (VI) 

|^[^a-zA-Z]+$ NoLETTERS  

\([\d]+\) NUMBERSbrackets Numbers in brackets with no spaces 

[\d\.\s,<>t\/]+ NUMBERSdotCOMMAtagSPACE Numbers including dots, OmegaT tags, commas, spaces in any combination. 
W/ "Full segment" activated: segments consisting only of numbers and/or 
dots and/or OmegaT tags and/or commas and/or spaces in any combination 
W/ "Partial segment" activated: not suited 

[\d]{1,}- NUMBERShyphen Numbers followed by a hyphen 

^[^a-zA-Z]*$ NUMBERSonly Segments only with numbers 

[\d]{1,}\s[\d]{3} NUMBERSseparSPACE Numbers with a space between groups of digits, e.g. (10 000) 

\([\d]{1,}\s[\d]{3}\) NUMBERSseparSPACEbrackets Numbers in brackets with a space between groups of digits, e.g. (10 000) 

\s\s+ SPACEdouble Segments with double space 

\b[A-Za-z]+\b $ WORDend Segment ends with word 
W/ NOT ticked: Segment does NOT end with a word 

(\b\w+\b)\s\1\b. WORDSrepeated Segments with repeated words 

^\b[A-Za-z]+\b WORDstart Segment starts with word 
W/ NOT ticked: Segment does NOT start with a word 
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1 –      : 
Ø The present  
Ø DGT-OmegaT-2014, its Project Wizard and DGT’s CAT Environment — A Translator’s Guide 
Ø DGT-OmegaT and its Project Wizard — A Translator’s Guide (2012). For translators who were already using the 

2012 version. 

2 –      . Take into consideration that DGT-OmegaT has some adaptations: 
Ø OmegaT 3.0 — User's Guide by Vito Smolej (the Guide in the OmegaT Help, but in pdf for easier consultation) 
Ø OmegaT for CAT Beginners by Susan Welsh & Marc Prior 

3 –      : 
Ø 3 videos  for the 2012 version of DGT-OmegaT (50 minutes on the whole: Video 1, Video 2 and Video 3 - DGT 

and its Project Wizard in a nutshell. Most of its content continues to apply to the new version of DGT-OmegaT 
Ø Videos on the Internet which describe some of the basic and more advanced features of OmegaT. 

 

Because I think people are important, I would like to thank: 

Ø First of all Didier Briel and the developers of OmegaT for their remarkable work and for being so attentive 
to translator’s needs… some of them being translators themselves! 
For a list of developers/contributors, see Help – About OmegaT 

Ø The enthusiasts that publish information, guides and videos that help me a lot to understand how OT works 
and made possible this Quick Guide, namely Vito Smolej, Susan Welsh and Marc Prior, Roman Mironov, 
Kos Ivantsov and the many contributors in the OmegaT User Group. 

 
Ø In DGT: 
 

v Rytis Martikonis, DGT Director-General, and Dieter Rummel, Head of DGT IT Unit, for being 
open-minded 

v Colleagues from the Informatics Unit:  
§ Alfons de Vuyst, Head of Operational Support and project leader 
§ Thomas Cordonnier, who developed the adaptations of the public versions of OmegaT to 

DGT and the improvements to the public version 
§ Elio Fedele, who developed the OmegaT Project Wizard and Clean Tag/TagWipe applications 

which make translators’ life so much easier 
§ João Rosas, who gave operational support to the testing of OmegaT and worked on the 

CleanTag/TagWipe application 
v Colleagues from the Portuguese Language Department: for their interest, feedback and questions, 

which allowed me to pinpoint what is more important for a new user... and also to “discover” 
features I hadn't noticed before and especially:  
§ Hilário Leal Fontes, who was also tester of OmegaT and who contributed a lot to this Quick 

Guide 
§ Mario Vilar, Helena Lopes dos Santos and Anabela Pombo Rodrigues. 

 


